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System requirements

Abstract:
WebSphere Host Publisher and HATS Limited Edition: 
Modernize Your Green Screen Applications!
Did you know that both WebSphere Host Publisher and 
HATS Limited Edition are included in the iSeries Access 
Family product? WebSphere Host Publisher is a tool you 
can use to reface and streamline those tired-looking green 
screen applications into truly web-looking applications 
without changing your original 5250 application -- you don't 
even need the source code nor do you need a great deal of 
programming skills!   HATS Limited Edition is another 
on-the-fly 'green screen eliminator' that requires no 
programming to use.  Simply install it and see how your 
users can work with all their iSeries screens and 
applications in a modern, GUI view.  These products 
eliminate PC network administration and desktop 
configuration as everything runs on the iSeries and only 
sends HTML to the browser.   You will also hear how Host 
Publisher compares to other IBM refacing tools.  By the 
end of this session, attendees will be able to:
1. Understand the capabilities of Host Publisher and HATS 
LE.
2. See how to use them in an iSeries network.
3. Know what steps to take next in order to start using 
them.

Agenda
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Packaging
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V5R2
5722-XW1

iSeries Access Family

V5R1
5722-XW1

iSeries Client Access Family
5722-XE1, V5R2
iSeries Access for Windows

5722-XE1, V5R1
AS/400 Client Access Express for Windows

5722-XH2, V5R2
iSeries Access for Web

5722-XH1, V5R1
iSeries Access for Web

5724-B81, V4.0
WebSphere Host Publisher

5648-E25, V3.5
WebSphere Host Publisher

Starting 6/30/2003
   HATS Limited Edition

Customers with Software Subscription can get 
V5R2 clients by ordering no-charge Feature No. 
2645 of Product No. 5722-XW1

After 6/30/2003, current V5R2 customers 
can get version of Host Publisher that runs 
on WAS V5 and HATS LE by ordering 
no-charge Feature No. 2646 of Product No. 
5722-XW1

After 6/30/2003, current V5R1 customers can 
get version of Host Publisher that runs on WAS 
V5 and HATS LE by ordering no-charge Feature 
No. 2646 of Product No. 5722-XW1

iSeries Access Family - Packaging
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WebSphere Host Publisher

A cross-server product

Included with iSeries Access Family (5722-XW1) at no additional charge...

Use your Host Publisher skills to 
work with iSeries and zSeries 
applications...

x
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Over the last several years, many products and technologies have been introduced to help extend legacy (typically 3270 and 5250 based)
applications and data to a web browser or Java interface.  Early solutions typically involved a fairly large Java applet being downloaded to a
workstation.  Others relied upon an HTML page and HTTP server mode of operation to provide the equivalent of a 5250 or 3270 
emulation session. The products have matured and there are numerous options available.

Despite the gold rush mentality on getting to the web, providing a browser interface over a heavily interactive application may not be 
suitable for the end user, especially when trying to exploit efficiencies by linking more closely to your customers, suppliers and trading 
partners. These users typically do not have experience with your application, plus have specific, targeted requests such as entering a 
purchase order or looking up account status. This is especially true in the business to business arena, where application to application 
integration and automation are important. However, organizations have invested literally billions in existing legacy applications that have 
been enhanced and solidified over the years. An ideal solution would be to encapsulate these robust legacy application tasks into reusabl
components that can be used for interactive web applications, as well as enterprise application integration projects for e-business and 
business to business transactions.

The basic objective of WebSpere Host Publisher is simple - enable an existing 5250 interactive application to participate in the e-busines
world, without having to do any code modifications.   With Host Publisher, you can:

Utilize the IBM Host Publisher product to provide a browser interface to our application
Build a Java wrapper layer, or adapter, that provides the data conversion and session management services to interface with the Host 
Publisher representation of our 5250 application
Utilize the IBM Connect for iSeries product and its Java connector option to enable an organization to participate in a business to 
business electronic marketplace, and leverage the strengths of our existing iSeries 5250 based order entry application 

You do not need to be an expert Java programmer, or purchase expensive, inflexible middleware from a dotcom vendor that may not be 
in business in a few weeks, in order to enable your legacy applications to participate in ebusiness opportunities.  You can use iSeries 
Client Access Family, that now includes WebSphere Host Publisher, and be confident that you have a solution that will be long lasting.

Notes: WebSphere Host Publisher
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Turns host applications into e-business applications for web browser users

WebSphere Host Publisher

Browser-based access 

Refaces and streamlines existing green 
screen applications and system screens

Existing green screen still available

Still interactive but Connections can be 
pooled
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Benefits to Your Programming Staff:

Feature/Function
They can:

Implement 'new look-and-feel' applications without needing host 
application source code
Work with:

      --5250/3270/VT host applications
      --Create new Database applications  using a variety of JDBC 
drivers 
      --Java Host applications

Consolidate multiple applications into a single web application
No programming required, you use the simple graphical 
wizard-like interface of Host Publisher Studio

Business value
Your Results:

Reduces the costs and risks associated with new application 
development
Since it is built on WebSphere technology it can be used other 
Websphere technologies to extend host data to pervasive devices 
like SmartPhone or personal digital assistants. 
Since it is based on open industry standards, it can be reused in 

other e-business applications  

Benefits to Your Business:

Feature/Function
You Can:

Put a GUI on green screens
Provide Internet access from any browser supported 
by WAS
Support new users inside and outside your enterprise
Extend the reach of legacy applications and data

--Streamline navigation through your applications 

Business value
Your Results:

Applications have a modern appearance
Applications are easier to learn and use
Lower training costs
Better responsiveness to your customers
More information available 24 X 7
Costly call centers and VRU's are offloaded
Existing transactions are streamlined

Notes: Benefits and Business value
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Server / 
Desktop 

Requirements

WebSphere Host Publisher 
V4.0

5724-B81

WebSphere Host Publisher 
V3.5

5648-E25
iSeries HW Interactive Interactive
Ports 80 (HTTP), 443 (HTTPS) 80 (HTTP), 443 (HTTPS)
Encryption SSL in browser SSL in browser
Browser Whatever supported by WAS 

(Netscape, Internet Explorer)
Whatever supported by WAS 
(Netscape, Internet Explorer)

Desktops 
supported

Any O/S with supported  
browser --  Windows  95, 98, 
Me, NT, 2000, XP, Linux, AIX, 
UNIX, Solaris, Macintosh, OS/2

Any O/S with supported  
browser --  Windows  95, 98, 
Me, NT, 2000, Linux,  AIX, 
UNIX, Solaris, Macintosh, 
OS/2

Server / Desktop Requirements...
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W
ebS

phere A
pp 

S
erver

W
ebS

phere H
ost P

ublisher S
erver

Internet iSeries 
Legacy
 Apps

IBM iSeries

GUI Delivered as a 
HTML

TELNET

Wireless devices

iSeries
pSeries
zSeries
xSeries

OS/390 

OS/400 

JDBC 

 DEC/UNIX 

Browsers
(Internet Explorer, 

Netscape...)

Multi-platform - server, connecting users
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WebSphere Host Publisher offers many capabilities

5. Can combine portions of multiple 
panels or multiple applications 
into a single Web view

5250, 3270...

6. Includes capabilities to control 
heavy Web use and large 
networks

Tools to enhance performance, 
fallover when Web server not 
available, manage multiple servers 
from single administer console

7. Cross platform development tool
Skills invested in Host Publisher can
be used with zSeries and iSeries 
applications as well 

Extend existing applications to the Web...

1. Modernization done without source 
code

Host application continues to run as it 
always has...

2. Can Web-enable system screens 
Including iSeries commands (such as 
query a database file)

3. Can take an existing full-function, 
in-house application and present 
only selected paths to Web users... 

4. Can add database functions to 
existing host application

Can access information from any 
relational database
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This is a Mainframe Application but could just 
as well been an iSeries application
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User must provide a 
valid Security Code 
in order to access 
this application
This screen quite 
unnecessary

x

x

State of Virginia - Host Application
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Multiple paths 
through this 
application

Case Management System
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Note
Order listed changed

From: Law, 
Chancery, 
Criminal
To: Criminal, 
Law, Chancery

Several paths through 
application not 
included in this view

Check out
http://www.piner.com 
to see this application 
and others that have 
been modernized 
using Host Publisher

Webized only 3 paths through this existing application
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Customer Reference Application - before using Host Publisher

Porter County Indiana - Tax Details Screen
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Customer Reference Application - after using Host Publisher

Porter County
Tax Search Form
Tax Information Results
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"Porter County has experienced a strong demand to provide more convenient 
access to public records like tax and judicial data, and people expect the 
simplicity and familiarity of the web environment . 

WebSphere Host Publisher provided a rapid conversion of our AS/400 property 
tax application to a browser interface and allowed us to streamline the 
application by combining screens and functions. The result has been a 
significant reduction in retrieval errors, connectivity costs, and improved 
public satisfaction with our systems.

We have plans in the near future to convert two additional green screen 
applications for web access with Host Publisher. "

 Sharon Lippens, Director, Data Processing, Porter County, Indiana

Tell your customers to check out http://www.piner.com  to see other applications that 
have been modernized using Host Publisher

Customer Quote
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Kawasaki Motors U.K. 
supports its dealers and 
sales force over the 
Internet with WebSphere 
Host Publisher

Miami-Dade

Host Publisher saves 
citizens time while 
enhancing government 
efficiency

Other iSeries Customers using Host Publisher
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How Do You Use 
Host Publisher

to modernize your applications?
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WebSphere Host Publisher

Host Publisher Studio
simple interface
creates Host Integration 
Objects

Host Publisher Server
Run-time for 
Integration Objects
A WebSphere 
Application!

Wizard to create 
JSPs for rapid 
HTML views of 

host info
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Host Publisher provides the following benefits to the iSeries 
environment:

Provides Web integration with 5250, Java Database 
Connectivity (JDBC) and Java host applications without 
requiring any changes to the existing application itself.
Allows for easy consolidation of multiple applications into a 
single composite application or Web page for presentation to 
Web users
Includes and integrates with Websphere Application Server 
and Websphere Studio to provide a comprehensive solution 
for delivering host data to Web users and to new Websphere 
e-business applications. 
Works with Websphere Transcoding Publisher to extend host 
data to pervasive technologies such as SmartPhone devices and 
personal digital assistants. 
Provides a wide range of host access options: HTML to Web 
browsers, XML Gateway for Java applications, and reusable 
Host Publisher Integration Objects for Java applets and 
applications. 
Helps to leverage your investment in Host Publisher by using 
integration objects that are based on open industry standards 
that can be reused in new e-business applications, and 
reducing the costs and risks associated with new application 
development. 
Can be implemented without programming, using a simple 
graphical wizard-like interface. 
Includes IBM Network Dispatcher, which enables the balancing 
of user network traffic across a pool of Host Publisher servers. 

Notes: Host Publisher Makeup
Host Publisher is also comprised of two categories of components - 
development and runtime.   

The development component is called the 'Host Publisher Studio'.  It is a 
development toolkit that contains three components: 
1. Host access for interacting with 5250 application tasks (entering 

input, extracting output) and representing them as reuseable Java 
bean components 

2. Database access for performing SQL inserts, updates and deletes in 
conjunction with DB2/400 and representing them as reuseable Java 
bean components 

3. An interactive application builder for integrating Java components 
(host access beans, database access beans, or other Java applications) 
to build web enabled applications, using Java Server Pages (JSP) 

The runtime component is call the 'Host Publisher server'.  It uses 
WAS to provide the runtime support for Host Publisher applications. 
Host Publisher applications can contain multiple components (ie pieces 
of several 5250 applications, host screens and DB2/400 queries) from 
multiple servers (iSeries, mainframes, etc.), and represent these as part 
of a firewall-friendly, thin client HTTP- and HTML-based solution. All 
programming logic runs on the server, even the 5250 session 
management tasks. It is well suited for extending host application 
functionality over the Internet, without requiring the end user to 
download large client components or try navigating through an 
interactive 5250 application. Since the 5250 tasks run on the server 
and not the browser, you are not trying to 'force fit' a session-based 
protocol (TN5250) over a sessionless (HTTP) connection. This is an 
advantage over other HTTP-based products.
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Host 
Publisher  

Host 
Publisher 

Studio

Host 
Publisher 

Server

Development Environment
Uses task oriented, graphical user 
interface 
Generates Integration Objects
Contains Java bean factories
Generates fully customizable Web 
pages (ie, Java Server Pages) 

Run Time Environment
Provides session management, license 
monitoring, run-time administration, load 
balancing and log and trace management
Supports SSL encryption and DES encrypted 
passwords
Supports integration with other IBM 
connectors

Development environment is 
a task-oriented, graphical 
user interface that runs on a 
PC with Microsoft Windows

Run time environment 
runs on WAS on iSeries

Key Components
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1. Install/configure Host Publisher Server 
in WAS

get it ready for use

2. Start the WebSphere Host Publisher 
Studio

Host Access (5250, 3270, VT) or 
Database Access (JDBC) paths

3. Step through the application or host 
screens -- capturing the information 
you wish to publish

generates Java beans called Integration 
Objects

4. Import the Integration Objects into 
the Host Publisher Application 
Integrator (studio)

generates JSPs and J2EE.ear files

What are the steps?

5. Perhaps polish your 
application further

5. Could use a product in the 
WebSphere Studio family or 
other products to enhance 
the graphical look of the 
pages 

6. Install the J2EE files on the 
application server using WAS 
Administrator

7. Ready for Web users to enter 
url to access the application
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Step 1.
Install/configure Host Publisher Server in WAS

get it ready to use
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Product 
Number Product Name Option $

57xx-SS1 OS/400 V5R1 or later Base w/HW
57xx-SS1 Operating System/400 Host Servers 12 N/C
57xx-SS1 Operating System/400 Qshell Interpreter 30 N/C

57xx-SS1
57xx-AC2

or
57xx-AC3

If you plan to use Secure Sockets Layer (SSL):
OS/400 Digital Certificate Manager 
Cryptographic Access Provider (56-bit)

                         or
Cryptographic Access Provider (128-bit)

34 N/C
N/C

N/C
57xx-DG1 IBM HTTP Server for iSeries N/C
57xx-JV1 Developer Kit for Java

Developer Kit for Java Version 1.2
Base

3
N/C
N/C

57xx-JC1 Toolbox for Java N/C
57xx-TC1 TCP/IP Connectivity Utilities for iSeries N/C
57xx-XW1 iSeries Client Access Family

WebSphere Host Publisher (5648-E25, V4.0) or
WebSphere Host Publisher (5724B81, V3.5)

$

5733-AS3
5733-WA3
5733-WS4
5733-WA4

WebSphere Application Server - Standard Edition V3.5
WebSphere Application Server - Advanced Edition V3.5
WebSphere Application Server - Advanced Single V4.0
WebSphere Application Server - Advanced Multi V4.0 
Will support WAS 5.0 versions by 6/30/2003

N/C
$
$
$

Server Software Requirements
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WebSphere Host Publisher is included with iSeries 
Access Family (5722-XW1):

Production environment must be installed on iSeries 
servers

Does 'Concurrent' license checking at runtime

Must have iSeries Access Licensed Program Product 
(5722-XW1) installed on Server.

If you have a Processor-based license of 5722-XW1, 
unlimited number of users could be using Host Publisher, 
Access for Web Access, and Access for Windows 
products simultaneously 

OS/390 

OS/400 

JDBC 

 DEC/UNIX 

HTML Web 
browser

Host Publisher Ts & Cs
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WebSphere Host Publisher Server  - CD

To be installed on iSeries

Host Publisher documentation included on CD

Planning and Installation Guide for iSeries

Administrator's and User's Guide. 

WebSphere Host Publisher Studio - CD

To be installed on Windows 98, Me, NT 4.0, 2000, or XP

Also look at iSeries Access for Web Installation Guide (SC41-5518) and README for 
additional information on installing and configuring WebSphere Host Publisher.

Use this for 
Host 
Publisher 
too

What Comes in Your Package...
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Performance mainly dependent on WebSphere Application Server
Minimal network traffic as only generating HTML page
Run the workload estimator at:

http://www-912.ibm.com/supporthome.nsf/document/16533356

Also look at recommended minimum system requirements for WebSphere 
from above web page

Use First Customer Assist Program to get WAS configured and running
http://www-919.ibm.com/servers/eserver/iseries/developer/

                    websphere/assistance.html

Performance Considerations
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First Install Customer Assistance for Websphere Application Server Standard  or Advanced Edition for iSeries or AS/400.
 

We would like to welcome new customers to the Websphere arena and provide them with assistance that may be needed to 
install and configure Websphere Application Server, either Standard or Advanced Edition.
By starting with a working instance of Websphere Application Server and reviewing the sample programs provided, your time 
spent with Websphere Application Server will be more productive and enjoyable.  
Through your application and acceptance into this program, the Rochester Support Center will provide you with 8:00AM - 
5:00PM Central Standard Time phone support assistance in setting up a Websphere Application Server test environment.

 This assistance includes:
1. Documentation clarification
2. Verify you have all Prerequisites available: Software, Hardware, PTF's, and Communication configurations
3. Creation of a default Websphere instance 
4. Configuration and enablement of Websphere for an HTTP server 
5. Installation and use of Websphere Client based Admin Console (excluded Firewall configuration) 
6. Validate the above by running of a sample servlet. 

http://www.iseries.ibm.com/developer/websphere/assistance.html

Notes: First Install Customer Assistance
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2. Start the WebSphere Host Publisher Studio
Host Access (5250, 3270, VT) or Database Access (JDBC) paths

3. Step through the application or host screens -- capturing the 
information you wish to publish

generates Java beans called Integration Objects

4. Import the Integration Objects into the Host Publisher Application 
Integrator (studio)

generates JSPs and J2EE.ear files

Steps 2-4.  Working with the Studio
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WebSphere Host Publisher Studio
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Host Publisher Studio is divided into 3 parts for creating and 
managing a project

1. 'Host Access' for your 
existing 5250 applications

Generates JavaBeans called 
Integration Objects 

2. 'Database Access' is used to 
create new SQL requests 

Generates SQL Integration Objects

3. 'Host Publisher Studio' / 
'Application Integrator'

Generates HTML, JSPs, and J2EE.ear 
files

Development Environment Components
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There are three unique 
steps you go through 
when using the 'Host 
Access' or 'Database 
Access' functions

These phases become 
your interaction macros

1. Connect and log on 

2. Navigate and extract 
data 

3. Log off and disconnect 

Notes: Working through the phases...
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To work with an existing 5250 application
We start by selecting 'Host Access' and start working through the Wizards.

First we define what we're going to do...

Working with 'Host Access'...

Watch on the 
left as Host 
Publisher is 
building the jsp 
(presentation)
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The 'Host Access' component works with existing 
5250, 3270, and VT applications or host screens 
to provide data and functions in a web page

Host Access interacts with host tasks
Host 'green screen' applications or system screens (ie, OS/400 screens such as 
working with spool file)
Entering input, extracting output
Represents them as reuseable Java bean components
Data from multiple host applications or system screens can be combined in a 
single web page 

Benefits
Host Publisher hides the complexity of obtaining the data
No changes to host applications needed!
Mission critical data can be presented to new users in new ways

Notes: Host Access
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Step through 
your 
application
Picking the 
input/output 
fields you 
want to 
display
Look on left 
now...

Capturing your screens...
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Remember 
that Porter 

County 
Application?

Telling Host Publisher what fields you want to present...
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Continuing 
through the 
5250 
application
Identifying 
what you wan
to display...
Look at left 
side now...

Working through the studio wizards...
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You can use the Host Publisher Display Terminal function for 
debugging

You can run the 5250 application in its green-screen view right next to your 
modernized application
Enables you to see the paths through your 5250 application that your 
modernized application is going to take.

Testing and Debugging your web application...

F
0
3
S
P

2
2
H

o
st

P
u
b
li
sh

e
rV

4
.p

rz

4
0



IBM eServer iSeries

© 2003 IBM Corporation

Database Access - select JDBC driver
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The 'Database Access' component is used to create Integration 
Objects that can access databases

Supports any relational database that provides JDBC drivers

Can access DBA data over the network using JDBC driver in 
DBA Connect

Database Access enables you to:

Perform SQL inserts, updates and deletes in conjunction with
DB2 UDB for iSeries, and 

Represent them as reuseable Java bean components 

The 'Database Access' wizards are used to 
create SQL Integration Objects that can 
access relational databases

Includes:
iSeries 
JDBC 
driver
AS/400 
Toolbox 
for Java

Notes: Database Access
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Wizard builds SQL 
statements

Tables
Join
Condition
Columns
Sort
SQL
Insert
Update

Now use Database Access wizards to built database 
application...
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The Database Access application enables you to create an 'Integration Object' that encapsulates a database statement.  
This Integration Objects are reusable building blocks you can use to build Web pages in Host Publisher Studio or your 
own server-side Java components such as servlets or Enterprise Jave Beans.

The Database Access application provides a wizard interface that enables you to quickly create, modify, and run 
Structured Query Language (SQL) statements.  With the wizard, you can query a relational database to retrieve data from 
the tables in the database, or update or remove a database entry.  You do not need to know SQL syntax to complete the 
wizard.  Tabs guide you through the process of building and executing a valid SQL statement.  You can navigate by clicking 
a tab at the top of the window or Back or Next at the bottom of the window.  Click Finish to save the Integration Object 
with the information you have typed.  Finish displays a save dialog box for you to specify a name for the Integration 
Object.  If you did not specify a User ID on the Connection Pools tab, the User ID Warning dialog box reminds you that 
the field is empty, which may cause an error at runtime.  Finish is enabled when you have connected to a database and 
selected the tables to access on the 'Tables' tab.

Before you start, ensure that the database client software is installed and configured on your workstation.  Specify the Java 
database connectivity (JDBC) address for the database.  The format of the database address depends on the JDBC driver 
you use to connect to the database.  If you select one of the JDBC drivers from the drop-down list in the Driver field, the 
required format for the driver is displayed in the Database URL field.  For example, the AS/400 Toolbox for Java JDBC 
driver requires jdbc:as400://[host], where host is the fully-qualified network name of the database host.  The square 
brackets ([ and ]) surrounding the host and database variables must be removed from the syntax when you enter the 
variable value.

Notes: Using Database Access wizards
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The 'Application Integrator' component is an interactive application 
builder for integrating Java components

Host access beans

Database access beans

Used to build composite applications 
Java beans and objects to be combined with other back-end data sources to create 
a composite Web application

Java is presented as a consolidated application
Allows for the publication of any Java bean or object to the Web

Facilitates interaction with that object

The 'Application Integrator' component 
is used to build Java Server Pages 
(JSPs) and J2EE.ear files

Host Publisher Studio - Application Integrator 
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Skills / Education
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Skills you need to use Host Publisher

Host Publisher Studio provides 
the tools to develop 
web-enabled applications

You must be proficient with the 
host application or database

You will use the Host Publisher 
Studio wizards to create java 
objects

Do not need to be a Java 
programmer

You will use the Host Publisher 
Studio wizards to build Web pages 
for the applications 

Basic JSP knowledge is 
required to modify the 
applications

Skills
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You need to understand the data source well enough to model interactions with the data 
source (which may be a complex process)

You need to be able to predict all possible paths, including error paths
If you are not familiar with the data source, then building the Integration Objects 
may be a painful exercise with much time spent starting over

You build and test the Integration Objects within the Host Publisher Access User 
Interface first.  You:

Model tasks, not screens
Identify tasks to be performed
Build a flow diagram and exercise the diagram
Allow for error paths (or prevent them effectively)
Allow for global screens (screens which could appear at any time)

You build pages to complete the application and TEST
You can customize pages to suit standards.
Once the application has been thoroughly exercised and tested, you then save the 
customization of the JSP pages

Skills for building a Web application...
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The Host Publisher Studio allows you to import the integration object created from the 5250 application example, and 
define a web browser interface for entering the input data, and receiving the output. As with the host access toolkit, 
the studio provides an interactive wizard that helps you get started quickly.    It is important to reiterate that you do 
not change the original application and you don't even need access to the OS/400 display file source. 

If you can write your own applications using the beans or HACL interface directly gives you a great deal of control, 
however it requires utilizing some fairly low-level programming techniques.  It also requires developers to handle 
situations (such as screen recoginition and waiting for the session's input inhibited indicator to clear) before processing 
the next step.  To avoid having to do this tedious coding, Host Publisher gives you a much easier means of interacting 
with the 5250 application, and it creates Java bean components that you can then utilize in your own application 
development tools, such as IBM VisualAge for Java.  Host Publisher is often more than adequate for building the 
appropriate solution. For more demanding application requirements, one can import these integration objects into a 
full-fledged Java IDE such as VisualAge and build solutions. 

See the simple example Building A Java Adapter Over a 5250 Application to enable B-B transactions at 
http://www.iseries.ibm.com/developer/java/topics/hostpubadapter.html  that shows an example of taking an interactive 
5250 application, then introduces you to 'web enabling' it via the Host Publisher product.  Next,  you will use this web 
integration infrastructure to create what is commonly termed as an adapter.  Put simply, an adapter is analogous to a 
human translator that provides interpretation between people that do not speak a common language. In this case, the 
Java adapter understands the interactive 5250 application transaction flow and structure of the input and output data. 
The adapter also understands a Java runtime environment direct program call.  This allows applications such as Connect 
for iSeries to take advantage of the robust, well-tested 5250 order entry application infrastructure running on an iSeries 
machine, and make it accessible via a web browser.    For interactive, browser-based applications. 

Notes: Host Publisher Sample Programs
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IBM WebSphere Host Publisher 
Application Development Workshop

Course Code:  SW910
For schedule information, call 
1-800-IBM-TEACH (426-8322)

'Building A Java Adapter Over a 5250 
Application to enable B-B transactions' 
article

An example of taking an 
interactive 5250 order entry 
application running on an iSeries 
machine, and making it accessible 
via a web browser
http://www.iseries.ibm.com/developer/
java/topics/hostpubadapter.html  

  

Programmer's Guide
On Host Publisher Studio 
CD

Assistance
eServer Custom Technology 
Center (CTC) 

Tutorial on CD
Contact Carole Miner for 
copy

Host Publisher - Education
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IBM WebSphere Host Publisher Application Development Workshop (Course Code:  SW910) - 

this course is for anyone that wants to build Host Publisher applications across a variety of platforms (not just iSeries) 
and who has basic web application development  skills including HTML knowledge and an understanding of the Java 
programming Language.   The focus of this course is on implementing IBM Websphere Host Publisher (Host Publisher) 
applications using advanced techniques designed to handle a wide variety of application scenarios. Advanced topics will be 
discussed to give the student in-depth understanding of Host Publisher technology and how to apply this technology to 
real-world applications. Labs will be used extensively to ensure  students can apply the topics discussed.  The Host 
Publisher Application Development Workshop is a technical workshop that will discuss techniques for developing 
advanced Host Publisher applications.
Duration:   4 Days
Delivery Method:   Classroom
Skill Level:   Basic
Tuition:   $2200 

For schedule information, please call 1-800-IBM-TEACH (426-8322).

Notes: Host Publisher Education
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Redbooks 
iSeries Access for Web V5R2 and WebSphere Host Publisher 
V4.0, SG24-6804-00 on the web at: 
http://publib-b.boulder.ibm.com  
/cgi-bin/searchsite.cgi?query=SG24-6804
A Comprehensive Guide to IBM WebSphere Host Publisher V3.5, 
SG24-6281 
New Advanced Functions in IBM WebSphere Host Publisher V2.2: 
Access Host Applications from Web Devices, SG24-5964-00 
New Advanced Functions in IBM WebSphere Host Publisher V2.2 
- Access Host Applications from Web devices, SG24-5964-00 
Building Integration Objects With IBM SecureWay Host Publisher 
Version 2.1 , SG24-5385-00 

White papers 
IBM WebSphere Host Publisher Version 4.0 Implementation 
Guide 
ssRTE.exe for use with Lab 1 in Implementation Guide [Executable 
- 139 KB] 
Setting up and Using the IBM® Express Logon Feature for 
WebSphere Host Publisher 3.5 
IBM WebSphere Host Publisher Version 3.5 Implementation 
Guide 
IBM WebSphere Host Publisher [PDF Version- 200KB] 
Using WebSphere Studio with Host Publisher 
Designing an Application Using IBM WebSphere Host Publisher 
Understanding Host Publisher Integration Object Chaining 

Product documentation 
IBM Websphere Host Publisher V4.0 Readme 
IBM WebSphere Host Publisher V4.0 Administrator's and User's
Guide
IBM WebSphere Host Publisher V4.0 Programmer's Guide and 
Reference
IBM WebSphere Host Publisher V4.0 Messages Reference
IBM WebSphere Host Publisher V4.0 Planning and Installation G
for IBM AIX, Sun Solaris, and Microsoft Windows 
WebSphere Host Publisher V3.5 Application Development: Build
Integration Objects for use in Java Server Pages: Lab 1 
WebSphere Host Publisher V3.5 Application Development: Build
a Integration Object Chaining Application- Lab 2 
WebSphere Host Publisher V3.5 Application Development: Usin
Conditional Macros, Error Logic and Global screens - Lab 3 
IBM Websphere Host Publisher V3.5 Readme
IBM WebSphere Host Publisher V3.5 Administrator and User's 
Guide (GC31-8728-02) 
IBM WebSphere Host Publisher V3.5 Programmer's Guide and 
Reference
IBM WebSphere Host Publisher V3.5 Planning and Installation G
for Windows NT, Windows 2000, AIX, and Solaris (SC31-8730-
IBM WebSphere Host Publisher V3.5 Planning and Installation G
for iSeries (SC31-8734-03) 

Key informational websites or links
iSeries Access Family:  www.ibm.com/eserver/iseries/access
Host Publisher:  www.ibm.com/software/webservers/hostpublish

http://www.ibm.com/software/webservers/hostpublisher/library.html
Reference Material (Redbooks, manuals, whitepapers, etc.)
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Step 5.
Perhaps polish your application 

further

Could use a product in the WebSphere 
Studio family or other products to enhance 

the graphical look of the pages 

pretty as a picture...

First we use the Host 
Publisher Studio to create 
our basic Web-to-host 
application, then we make it
'production ready'
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To get this kind of look takes an extra step...

You will want to use a product like 
IBM's WebSphere Studio products 
to enhance the presentation of the 
application
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The following steps describe how to import Host Publisher generated 
JavaServer pages (JSPs) into WebSphere Studio

Create the application with Host Publisher Studio
1.Install sample application UofMApp1.hpa Note: UofMApp1 and
   UofMApp2 are installed together, so you can skip this step if
   UofMApp2 is already installed.
2.Start Host Publisher Studio from the Start menu. 
3.Close the opening Welcome to Host Publisher Studio! dialog box,
    if it appears. 
4.Open the sample application as follows: 
    1.From the menu bar, select File > Open Application.... 
    2.Double-click the UofMApp1 folder in the Open Application File
       dialog box. 
    3.Select UofMApp1.hpa. 
    4.Click Open. 
5.Click File > Transfer to Server... to transfer the sample application
   to the Host Publisher Server. Refer to the IBM WebSphere Host
   Publisher Administrator's and User's Guide for details. 
6.Use Host Publisher Server Administration to deploy UofMApp1.
   This final step makes the application available on the Web. 

Import the JSPs into your WebSphere Studio project
7.Start WebSphere Studio from the Start menu. 
8.Select Create a new project from the Welcome to IBM
   WebSphere Studio dialog box. If this dialog box does not appear,
   click File > New Project... from the menu bar. 
9.Type UofM1 as the Project Name, then click OK. 
10.Import the Host Publisher Studio-generated JSPs as follows: 
      1.From the menu bar, select Insert > File.... 
      2.Select the Use Existing tab in the Insert File dialog box. 
      3.Click Browse and navigate to the
                 x:\HostPub\Studio\UofMApp1 folder. 
      4.Press and hold Ctrl, then click inputPage.jsp and
         outputPage.jsp to select them both. 
      5.Click Open, then click OK. 

Notes: Managing Host Publisher Studio-generated JSPs in WebSphere Studio 

Modify the JavaServer Pages within WebSphere Studio
11.Double-click inputPage.jsp in the File View window to open Page 
Designer with the selected file. 
12.Apply your creativity to enhance the page. When you are done, click File 
> Save to save the revised file, then click File > Quit to close Page Designer. 
13.Repeat the process to enhance outputPage.jsp as desired. 

Publish the modified JSPs from WebSphere Studio to Host Publisher 
Server
Note: Your publishing target must be a Host Publisher Server. 
14.Configure WebSphere Studio to publish the JSPs to the correct Host 
Publisher Server application directory as follows: 
     1.Select the Publishing window and expand the publishing stage with
         which you are working. 
      2.Right-click on the server and select Properties from the pop-up menu. 
      3.Click Targets... in the Properties dialog box. 
      4.Set the html target to the corresponding application directory on your 
Host Publisher Server target (for example, 
                   x:\HostPub\Server\production\documents\UofMApp1). 
       5.Click OK to close the Properties dialog boxes. 
15.Configure WebSphere Studio to publish files with relative links: 
       1.From the menu bar, select Tools > Publishing Options.... 
       2.Check Relative to parent file for Style of links. 
       3.Click OK to close the Publishing Options dialog box. 
16.Publish your WebSphere Studio project. Note that you may see warnings 
about broken child links in inputPage.jsp and outputPage.jsp. You can safely
ignore these warnings and click OK in the Files to publish dialog box. The 
warnings can be ignored because your earlier transfer from Host Publisher 
Studio has already installed the additional files. Click here for more details. 

Test your modified application
You can access your modified Host Publisher application with the same URI 
used for the original application. For example, the sample application 
deployed here can be accessed at  

http://your.HostPublisherServer.com/HostPublisher/
UofMApp1/inputPage.jsp. F
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IBM WebSphere Development Studio Client for IBM iSeries V4
Included with WebSphere Development Studio for iSeries, Product Number 
5722-WDS (processor-based)
Or can purchase stand-alone Product Number 5724-A81 (user-based)

iSeries-specific enhancements for Java development 
iSeries-specific enhancements for Web development 
Integrated workstation based iSeries development tools including Remote System 
Explorer/Remote System Framework and JLpex editor 

See Software Announcement Letter 202-127 dated June 4, 2002

This tool will satisfy the needs of most iSeries developers...
iSeries specific enhancements are included in these Web and Java developments 
tools to make it easier to develop Web and Java applications for the iSeries server.   
However, this Development Studio for iSeries does not provide support for applications 
requiring the use of EJBs or J2EE. 
For these functions, iSeries developers need to use WebSphere Studio Site 
Developer Advanced. 

WebSphere Tools
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WebSphere Studio Application Developer (V4.0.3 for Linux and Windows)

Part Number 45P8105 (user-based) 
A powerful Java development environment that supports JDK 1.3, configurable runtime, 
incremental compilation, scrapbook, dynamic debugging, and refactoring 
Advanced Web, Java, and XML development environments designed to J2EE 1.2 
specifications 
Web services tools to quickly develop, describe, and deploy Web services-enabled 
applications based on open, cross-platform standards like UDDI, SOAP, and WSDL 
A Relational Schema Center focused on relational database design and database 
administration tasks such as import and mapping schemas and other advanced 
functions 
An integrated roles-based team environment 

For more information, see http://www.ibmlink.ibm.com/usalets&parms=H_202-057

WebSphere Studio Application Developer is an easy-to-use, integrated development 
environment for building, testing, and deploying J2EE applications that rapidly grows and 
adapts to meet the most stringent business demands.  This WebSphere Studio 
Workbench-based product is designed for Java and J2EE developers requiring integrated 
support for Java, EJB, Web, Servlets, JSP, XML and Web services. Additionally, it offers 
many quality and productivity enhancement functions to help you shorten development 
and test cycles. 

Other WebSphere Tools... 
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Step 6.
Install the J2EE files on the application server 

using WAS Administrator
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Step 7.
Install the J2EE files on the application server 

using WAS Administrator
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Host Publisher Server (Runtime)

Can administer 
multiple Host 

Publisher Runtime 
Servers from one Host 

Publisher 
Administrator 

Console 

WAS

Windows 
NT 4.0, 
2000, XP

Administrator 
Console

Working With the Server Side
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The navigation pane 
on the Host Publisher 
Administration page 
contains functions for 
the Host Publisher 
Server 

Server Status 
Administration 
Connections 
Application 
Administration 
Problem 
Determination 
Tools 
Set Trace Options 

Mature...
Scalable...
Available...

Fine-Tuning the Host Publisher Server for the Web
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Connection Manager
Set of Java classes 
Encapsulates connection management

Session creation, priming, and destruction
Connection pooling
Userid/password pooling functions
Support Host Access (3270, 5250, VT) and Database (JDBC) 

Administration
Java servlet and associated JSP pages
Accessed via Web browser
Monitors and controls state of run time environment

start and stop server
license management
pool management

Connection manager
Application Administration

Problem determination
XML Legacy Gateway Administration

New Capabilities In Host Publisher V4.0:

Multi-language support 
When using Host Publisher Administrator (on server) 
can view the Host Publisher documentation in  
languages other than the server's default language

Software Maintenance Utility
A new command-line tool to help you apply software 
fixes

Notes: Host Publisher Server
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Typical security mechanisms available 
through the Web can be used to control 
authentication and access to existing 
applications including:

Secure Socket Layer (SSL) for data 
encryption between browser and web 
server as well as authentication

Secure Socket Layer (SSL) also provides 
encryption between Host Publisher and 
Host applications

Security mechanisms deployed for host 
application systems remain available to 
control access and authorization

Secure access to Web applications and 
Host Publisher Administration by using 
access controls provided in WAS and 
HTTP server

Internet

HTTP or 
HTTPS port

Telnet to 
5250 
application 
(can used 
SSL)

SSL in the 
browser

5250 
application

5250 
application

WAS

Security Features...
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Application Caching

Precompiles page into a Java Servlet

If someone else asks for same page then the servlet is rerun

Page recompiled only when it changes
Increases transaction rates and gives faster response time

Connection Pooling

For JDBC and 3270/5250/VT access 

Pool of connections open to data sources

Can specify that all requests serialize on connection cache (so 
if 25 connections in pool and in use then 26th request waits 
for free connection) or can specify that once initial "X" 
connections in use then create an "X+1" connection

Performance Features...
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Supports WAS Workload Management features

Vertical and horizontal cloning
Can have multiple JVMs in WAS, and these can be clones

Vertical cloning is limited to one machine (vertical cloning), and 
horizontal cloning is spread across multiple machines

Benefits are:
Improved throughput as requests can be distributed across multiple 
JVMs

Better fault tolerance because if one JVM fails the user request can 
be processed by any remaining clone that can handle the request. 

If someone else asks for same page then the servlet is rerun 

Vertical cloning is also useful when configured on a machine which is 
powerful enough that a single JVM cannot effectively utilize its CPU 
power (such as on a multiprocessor machine)

RAS Features...
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Support for WAS V4.0 (J2EE compatibility)  
Support for AEs, AEd and AE
This includes migration of Host Publisher applications to achieve J2EE compatibility

Web Services
Quickly extend legacy services as new web services
IOs and EJBs are enabled as Web Services. Web Services creation occurs in WebSphere 
Studio

WebSphere Portal Family support
Extend legacy content as new portal content- WPS 2.1

Accessibility (CI 162)
Web applications produced by Host Publisher Studio are accessible
Keyboard accessibility for all components but HP Admin and DB access.
Added documentation of accessibility features

Server Multi-Language support
Host Publisher Administrator and documentation 

Serviceability tools
Software Maintenance Utility and Information Bundler

iSeries two stage install (install and config)

Host Publisher V4.0 Enhancements
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Web Services provide a way for applications to connect and interact on the Web more easily and efficiently.  Web Services are 
self-contain, modular applications that can be described, published, located, and invoked over the Web.  Platform-neutral and based on 
open standards, Web Services can be combined with each other in different ways to create business processes that enable you to 
interact with customers, employees, and suppliers.

Typically, Web Services use Internet protocols, such as HTTP, use XML message formats, and are plugged into Web Service registries 
where other developers can combine and deploy them.  Think of them as strategic building blocks for automated business processes that 
can be deployed across your enterprise and shared with other enterprises.

Support for Web Services has been implemented in a number of IBM software products, including WebSphere Application Server and 
WebSphere Studio tools (such as WebSphere Studio Application Developer) at the 4.0.2 level or above.

You can use the Host Access and Database Access components of Host Publisher Studio to create supporting files that enable Host 
Publisher Integration Objects and EJB Access Beans to be deployed as Web Services.  Application Integrator assembles these Java objects 
(and optionally JSP pages that reference the Java objects) into a J2EE .ear file.  You can them import the .ear file into a new or existing 
WebSphere Studio project, where you can create and deploy Web Services.

To create an Integration Object in Host Publisher and then enable it to become a Web Server, you would perform the following steps:
1. Using Host Publisher Studio and create 1 or more Integration Objects or EJB Access Beans with Options > Create Web Services 

Integration Object Support checked.
2. Import the Web Services Integration Objects or EJB Access Beans into Application Integrator.  Create an applications that consists of 

Web Services Integration Objects, EJB Access Beans, or both, and then generate an .ear file for the application by clicking File > 
Create J2EE Archives.

3. Import the .ear file into a J2EE-enabled WebSphere Studio tool (for example WebSphere Studio Application Developer).
4. Use the WebSphere Studio tool to create a Web Service.
5. Generate a sample application and run it to test your Web Service.
6. Complete development and testing of the application you imported in step (3).
7. Deploy the completed application.

See White Paper 'IBM and the Strategic Potential of Web Services' at 
http://www-3.ibm.com/software/solutions/webservices/pdf/May13_IBM_WebServices.pdf

Notes: Web Services
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Step 7.
Ready for Web users

 to enter url
 to access the application
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WebSphere Host Publisher (V4.0) - Studio
provides National Language Versions (NLVs) 
for:

Chinese (Simplified and Traditional)
English
French
German
Italian
Japanese
Korean
Portuguese (Brazilian)
Spanish
Turkish

New in WebSphere Host Publisher V4.0:  
Multi-language support 
When using Host Publisher Administrator (on 
server) can view the Host Publisher documentation 
in  languages other than the server's default language

WebSphere Host Publisher (V4.0) - Server 
provides National Language Versions (NLVs) 
for:

Chinese (Simplified and Traditional)
English
French
German
Italian
Japanese
Korean
Portuguese (Brazilian)
Spanish
Turkish
Arabic
Belgium Dutch
Croatian
Czech

Danish
Dutch
Finnish
Hungarian
Norwegian - Bokmal
Polish Language
Portuguese
Portuguese MNCS
Romanian
Russian
Slovakian
Slovenian
Swedish 

WebSphere Host Publisher NLVs

Note:  WebSphere Host Publisher does not 
support secondary languages.
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Host Publisher - Key Differentiators

Can take an existing full-function, in-house 
application and present only selected paths to Web 
users... 

Can merge/split applications and screens

Can translate system screens also

Source code not required

Existing green screen still available 

Supports multiple types of user interfaces

5250, 3270, etc

Easily extend just a portion of existing applications to the Web...

This tool enables 
you to 'really' take 
an existing host 
application and 
move it to the 
worldwide Web!
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Host Access Transformation Server (HATS)
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Host Access Transformation Server (HATS)

A Web-to-host HTML 

emulator...

3270, 5250...

with a rules-based 
transformation engine...

Converts green screens to 
graphical user interfaces 

(GUIs)...

in real time

Works with system screens 
too...
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Capabilities ...

HATS Studio plugs into the 
Eclipse-based WebSphere Studio, 

and provides an easy-to-use 
wizard-based environment for 

converting host screens to a web-like 
appearance and functionality

Easy Web-to-host first step
"Near" load-n-go implementation
Low skills requirement

Host screens are converted to 
GUIs on the fly, in real time

Preserves existing application flow

Eliminates need to customize 
every screen

Rules-based, customizable

Zero footprint on the desktop

Industry-standards 
HTML, HTTP, HTTPs
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The standard HATS application model dictates that all configuration is done in the HATS Studio (a plugin to WebSphere Developer Studio). 
Once configuration has been completed in the Studio, the application is assembled into an enterprise application; an application that then 
can be installed on a WebSphere Application Server. 

By the time a standard HATS application reaches the application server, configuration has already taken place in the HATS Studio. This 
application can be installed on the application server, started, and begin to service clients. 

Notes:  HATS 
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Example

HATS 
Transformation 
Using Default 

Rules

Traditional 
Green 
Screen
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iSeries Access Family 
iSeries Access for Windows
iSeries Access for Web
WebSphere Host Publisher
iSeries Access for Wireless
HATS Limited Edition 

WebSphere Host Integration 
Solution 

IBM Personal Communications 
(Intranet only)
WebSphere Host On-Demand 
WebSphere Host Publisher
WebSphere Host Access 
Transformation Server 
(HATS)  
IBM Communications Servers
IBM Screen Customizer   
WebSphere Studio Professional 
Edition (Internet only) 
WebSphere Application Server 
Advanced Edition 4.0 for 
Windows (development)

same product

Packaging

HATS LE subset of HATS

Available through Passport Available through iSeries
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HATS is shipped as part of the Host Integration Solution bundle
Announcement Date - 9/24/2002
General Availability 

12/2002 - Windows NT, Windows 2000, AIX, Solaris
1/20/2003 - iSeries
2Q03 Linux, zLinux
4Q03 - zSeries

HATS Benefits
Increases productivity and reduces training costs
Extends legacy applications to the widest possible audience...
Delivers HTML to Web browsers...
Presents host screens as familiar Web interfaces.
Host application user interfaces can be quickly delivered over the Web
Green screens converted to GUIs according to HATS default rules...
Further customization added as time and resources permit.
HATS Studio
Plugs in to the Eclipse-based WebSphere Studio
Easy to use wizard-based environment for converting host screens to a web-like appearance and 
functionality
No programming skills are required

Notes: HATS
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Key Differentiators - HATS

Rules-based data stream 
translator

Designer is plug-in to 
WebSphere Studio 
Development Tools

User interface customization 
available

Merge/split applications and 
screens

Translates system screens 
also

Supports multiple types of 
user interfaces - 5250, 3270
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Host Access Transformation Server 
Limited Edition

HATS LE

Part of iSeries Access Family - 5722-XW1
Available 6/30/03

Will automatically ship with new orders for 
5722-XW1
Existing iSeries Access Family customers can 
order no-charge Feature Number 2646 of 
5722-XW1 to receive HATS LE
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HATS Limited Edition
Runs in a browser

Delivers HTML to the desktop
Only software needed on the client is a Web browser

Uses browser SSL features

Works on all 5250 screens
Stock Templates included so you can quickly 
personalize your web page to your company look and 
feel

Screens are converted on the fly, in real time
Selection lists can be converted to hot links, buttons, 
drop-down menus, or option lists (radio buttons)

PF keys are can be converted to buttons or hot links

No programming necessary
Doesn't break if changes are made to 5250 application
No need to access source code

Runs on WAS V4 and V5 (including Express)

A quick and easy way 
to put iSeries 
applications on the 
Web
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HATS LE is a reduced-function version of HATS V4.  HATS LE is delivered in the form of a J2EE enterprise application. 
Customers will need to install this application on their application server. Once the application has been installed, started, and 
configured, web browser clients will be able to connect to and use it.

HATS LE is targeted for a lower skill set by eliminating the dependence on needing to use WebSphere Studio client tools to 
set up and run it.  HATS LE gives customers the ability to quickly get their host applications to the web by reducing the number 
of steps to configure the application, removing the requirement to install and understand WebSphere Studio client tools, and 
removing the complexity of customizing screens. HATS LE does not require administrators to have any HTML or Java skills.

HATS LE provides a new HTML-based Configuration Wizard to allow the administrator to set connection parameters, 
configure templates (including the ability to add corporate logos), and to change the default transformation settings.   HATS 
LE uses the existing default transformation from the standard HATS V4, and there is no ability to create custom 
transformations.  The Configuration Wizard is based on the HATS V4 Studio Project Wizard and Editor. 

Notes: HATS LE overview
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HATS LE: Real-time Screen Conversion

HATS LE 
on-the-fly 

conversion using 
customer-provided 
HTML (logo and 

graphics)

Traditional 
green screen

Drop-down 
menu 
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HATS LE - internal view

Administrative 
Console

Configuration 
Wizard

HATS LE will be delivered in the form of a J2EE enterprise application. 
Once it is installed/configured/started on the iSeries, web browser clients 

will be able to connect to a url and start using it.
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Server Requirements

HATS LE is designed to run on any platform 
supported by HATS V4, however, testing will be 
limited to iSeries only. The following application 
servers are supported:

WebSphere Application Server Advanced Edition 
4.043 and higher
WebSphere Application Server Advanced Edition 
Single Server 4.03 and higher
WebSphere Application Server Version 5.0
WebSphere Application Server Version 5.0 
Express

Client Browser Requirements

Clients connecting to HATS LE will have the same 
browser requirements as those users connecting to 
a standard HATS application:

Netscape 6.0 + and IE 5.0 +  
Netscape 4.72 (no keyboard support)

HATS LE administrators will have the same browser 
requirements as client browsers connecting to the 
application.

HATS LE - server/client requirements
Internationalization

GB18030 phase 1 certification.
Support for all languages and code pages at runtime.
BiDi support
DBCS characters will be supported in the customization wizard as well as 
connecting to DBCS codepage host applications.

The web- accessible  Administrative Console, and Configuration Wizard will be 
translated into the following Group 1 languages:

English
French
German
Spanish
Italian

Portlet Support
HATS LE does not run in the WebSphere Portal Server. Customers will need to 
upgrade to HATS to take advantage of this feature.

Online Help and Documentation
The following online information will be provided:

Readme/installation. PDF and HTML.Translated
Online help for wizard/dialog panels. HTML.Translated.

Online help will be available on all pages of the Configuration Wizard and, the 
Administrative Console, and the Application Builder. Context sensitive help will 
not be supported (as it currently exists in the HATS Studio) because this 
concept is not consistent with normal web-based applications. A link on each 
wizard panel will open online help for that panel in a new window.  A readme 
file, specific to HATS LE will be available to the administrator in the 
Administrative Console and to the user prior to installing the product.

Portuguese/Brazilian
Japanese
Traditional Chinese
Korean
Simplified Chinese
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HATS LE - Admin Console

Administrative Console
A web-based tool (different than the WAS administrative console) that allows the 
administrator to manage active connections, tweak configuration changes, 
active/deactivate the application, and launch the Configuration Wizard

 The Administrative Console can be accessed by navigating to 
http://serverName/HATSLE/admin

http://serverName/HATSLE/admin
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This is the default page shown for Administrative Console.  The administrator using either the Administrative Console or the 
Configuration Wizard will be prompted to enter a user name and password, and must have "SECADM" authority associated with his/her 
account. 

The overview page is the first page displayed to the administrator when they enter the console. This page will:
Show the status of the application (inactive/active)
Allow the administrator to change the status of the application
Show when the application was started
Show the current number of active connections
Show the peak number of active connections (and the date/time when that occurred)
Show host connection settings (IP address, port, etc)

Configure  - the Configure section will allow the administrator to configure the application; (using the Configuration Wizard). the 
Configuration Wizard will be launched in the right-hand side of the Administrative Console window. 

Manage Connections - the Manage Connections section will allow the administrator to manage all active connections to the 
application. 
This page will:

Show all active connections (in the form of a sortable table)
Show when each connection started, how long since the connection was used, the IP address of the client,  and the internal name of the 
session, the name/version of the browser the client has connected with, and the workstation ID of the connection.
Allow the administrator to view the current host screen of the user
Allow the administrator to terminate (stop) the session for one or more active connections

Advanced - the Advanced section will allow the administrator to configure more advanced settings of the application. This includes:
Editing the application.hap (for tweaking purposes)
Editing a selected template
Exporting the application (for importing into HATS)

Notes: Administrative Console
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Configuration Wizard
A web-based tool to enable the 
administrator to configure 
HATS LE

Steps that need to be 
performed are:

1. Set up connection settings
2. Define default template to be 

used
3. Set up default transformation 

settings, such as:
Converting PF keys into 
buttons
AS/400 subfile support
Color remapping
Other minor enhancements

HATS LE - Configuration Wizard

http://serverName/HATSLE/config
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The Configuration Wizard is a web-based wizard used to configure and prepare the HATS LE for use by clients.  The 
administrator can access the Configuration Wizard directly by:

Navigating to the URL http://serverName/HATSLE/config
Clicking the "Configure" option in the Administrative Console, or by
Navigating to the URL http://serverName/HATSLE/entry before the application has been configured. 

The first time HATS LE is accessed (or before it has been configured), a log-in page will be displayed.  The administrator will 
need to supply a user name and password before beginning configuration.  After the administrator has successfully logged in, a 
Welcome page will be displayed tol inform the administrator that he/she is about to begin configuring the application.

The Configuration Wizard is the main functional component of HATS LE, and all configuration takes places after the enterprise 
application has been installed on the application server, but before it can begin servicing clients, it needs to be configured.  The 
main objective of the wizard is to quickly and easily capture the needed information to get the application in service. The wizard is 
easy to understand and interact with and provides enough flexibility to make it useful.

Steps to be performed by the administrator in the Configuration Wizard:
Configure host connection parameters.
Select a default template, choose whether to show application or host keypads, and select whether to enable browser keyboard 
support.
Configure default transformation settings.

The Configuration Wizard has navigation buttons (eg, Next, Back, and Finish buttons) along the bottom of each page which allow 
the administrator to navigate between pages of the wizard. The navigation buttons will appear at the bottom of the wizard as 
needed. For example, the "Next" button will not appear on the final page of the wizard because there are no further steps to 
complete.These buttons will be enabled/disabled depending on whether the developer has supplied enough information to 
continue.  Validation of form values supplied by the administrator will be performed only on the server when the page has been 
submitted (either by clicking "Next", "Back", or "Finish"). The administrator will not be allowed to continue on to the next step until 
the current step has been successfully validated. 

Notes:  Installing and using Configuration Wizard
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Connection Settings

Host name

Port

Code page

Workstation ID

Set to a value (default)

Set from an HTTP 
session variable

Prompt user

Security

HATS LE - Connection Settings
1

http://serverName/HATSLE/config

serverName
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The first step of the Configuration Wizard is to ask the administrator to supply the host connection parameters. These settings define 
which host server the user connects to when he/she accesses the HATS LE. The administrator needs to supply the host name (or IP 
address) of the host system (a default value of "localhost" will be prefilled in this field), the port number (a default value of "23" will be 
prefilled in this field), and the code page. The administrator also needs to select how HATS will gain the workstation ID for each 
connection when that connection is initiated. The three options are:

Set to a value - this value can either be a hard-coded string (not recommended) or a string containing HOD-supported workstation ID 
wild cards and characters (see the HOD documentation for more information). This is the default selection.
Set from an HTTP session variable - a variable containing the workstation ID may have already been supplied (or calculated) in 
another JSP or servlet in the application, this option allows the developer to use this variable's value as the workstation ID for the 
connection.
Prompt user - ask the user to supply a workstation ID when he/she starts the application. A web-based dialog will be displayed to the 
user on application start prompting him/her for his/her workstation ID. The value supplied by the user will be stored as a cookie on the 
client browser and used to pre-fill the dialog on the next connection attempt. This dialog will be displayed in the preferred language of 
the client browser (unless that language is not supported).

The administrator also has the option to allow or not allow the user to supply a workstation ID in the URL (by supplying a value for the 
"workstationID" parameter). If this option is on, a supplied workstation ID in the URL will override any value (or configuration option) 
supplied by the administrator. For example, if the administrator has chosen to prompt the user for a workstation ID, but the user supplied 
a workstation ID in the URL, the user will not be prompted to supply a workstation ID, and the value in the URL will be used to initiate the 
connection.

The administrator can also select whether to enable SSL (secure sockets layer) security between the host server and the application 
server (if applicable). If SSL is enabled, the administrator can supply an optional security certificate.

Once all fields on the page have been filled in with valid values, the administrator is allowed to continue onto the next page. At this point, 
all required information will have been gathered from the developer and the Finish button will become visible. The administrator can 
choose to continue configuring the application or proceed to using the application.

Step 1 : Configuring the Connection Settings
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Templates included in 
HATS LE 

Blank

Classic Terminal

One that looks similar 
to iSeries Access for 
Web

HATS LE - set up screen background
2

Keypads, keyboard functions
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The second step of the Configuration Wizard is to ask the administrator to select a default template, or look, for the application. The 
following templates will be provided:

Blank
Classic Terminal
One that looks similar to iSeries Access for Web

Selecting a template in the list will cause a thumbnail preview of that template to be displayed. The administrator can tailor such 
things as the company name, company logo,  The administrator can also edit the JSP source of the template from the web to 
provide better consistency with current web applications. The feature will not be made available in the wizard, but only shown in the 
Administrative Console.

The administrator can also choose whether to show the application keypad and host keypad, and whether to allow end users to use 
their keyboards (when using a compatible browser) to interact with the host system (ie support for function keys and other 
designated key combinations).  Detailed configuration of the application and host keypads will not be made available in this wizard. 
By default, the application keypad, host keypad, and keyboard support options will be enabled.

Once the administrator selects a template, it can then be customized (if it has any customizable options) and previewed. Clicking the 
"Preview" button will show a preview of the template in a new browser with a sample host screen; to quickly see how the template will 
appear to the end user. Clicking the "Configure..." button will show the "Configure Template" 

Step 2 : Selecting and Configuring the Template
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Use the 'Classic' 
Template to look more 
like your current 
Corporate Site

Set up your:

Company name

Logo

Corporate Links

...

Customizing a Template 2a

http://serverName/HATSLE/config/configureTemplate.jsp?dsfdfff
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Each template shipped with HATS LE has a set of configurable settings (the size of this set depends on the complexity of the 
template). This will give the administrator the ability to customize the look of HATS LE.  Special JSP tags in the templates will be 
read at design time and a dynamic page of options will be displayed to the administrator. 

An example of this JSP tag is as follows:  <HATSLE:Template name="COMPANY_NAME" description="%company_name" 
type="String" defaultValue="My Company Name" configurable="true" />

The tag consists of these attributes:
name - the internal name, or key, of the attribute name (non-translated). Required.
description - the translated string displayed to the administrator during configuration. A description value preceded with a "%" 
will be looked up in an appropriate translated resource file. Required.
type  - the type of the value. Valid values include String, Image (gif/jpeg supported), Link List, and Stylesheet. Not required. 
Default value is "String".
defaultValue - the default value used if no value is specified by the user OR if the "configurable" flag is set to false. Not required. 
Default value is "".
configurable - a flag used to determine whether the administrator is given the ability to modify the value of this configurable 
option in the Configuration Wizard. Not required. Default value is "true".

Step 2a : Customizing a Template
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Default transformation 
features are:

Automatic selection list 
rendering
Automatic detection of PF 
keys on the host screen
Automatic subfile 
rendering
Automatic table detection

Can also configure:
What determines a PF 
key on the host screen 
(ie, delimiters, etc)
How those PF keys will 
be rendered (either as 
buttons or links).  

An end user connects to HATS LE by navigating to a URL:
http://serverName/HATSLE/entry or simply http://serverName/HATSLE

HATS LE - define end user 'look and feel'
3
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The third step of the Configuration Wizard is to customize how HATS LE will appear to the end user.  The administrator can turn on/off 
automatic detection of certain host screen components.  Default transformation features in a HATS Limited Edition application:

Automatic selection list rendering
Automatic detection of PF keys on the host screen
Automatic subfile rendering
Automatic table detection

Any or all of these features can be turned off by the administrator. The administrator can also configure different properties for each 
feature. For example, ability to configure what determines a PF key on the host screen (ie, delimiters, etc) and also how those PF 
keys will be rendered (either as buttons or links).  

HATS Limited Edition will take advantage of the default screen transformation technology already available in HATS.  The set of 
options for default transformation in HATS LE will be smaller than the set currently in HATS V4. The set of options is smaller because 
HATS Limited Edition is specifically targeting 5250 host applications which are generally more consistent in nature than mainframe 
hosts.

Connecting to the Application
The final interactive step of the Configuration Wizard is to allow the administrator to view the settings -- this includes host connection 
parameters, default template, customization settings, etc. The administrator can then accept these settings by clicking the Finish 
button. This will save the changes to the appropriate files.   The administrator then chooses whether to activate HATS LE.   It cannot be 
accessed by client browsers until it is actived. This option will be turned on by default.  Once the administrator clicks Finish, HATS LE 
will connect to the host and start; and the administrator will be presented with the signon page (presumably) of the host system. 

Once the administrator has configured HATS LE, an end user can connect to the application by navigating to the URL, 
http://serverName/HATSLE/entry or simply http://serverName/HATSLE.

 If HATS LE has been activated by the administrator, the user will see the first host screen on the configured host (assuming the 
connection parameters supplied by the developer were correct).

Notes: Step 3. Configuring Default Transformations
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Features in both HATS and HATS LE
Default host screen transformation
Configuration of host connection 
settings
Ability to chose a standard template
Ability to turn on/off application and 
host pads
Keyboard support

Features in HATS, not in HATS LE
Screen customizations
Support to play and record macros
Text replacement
Support for global variables
Support for custom Java business 
logic

Differences - HATS vs HATS LE

Customers with 5722-XW1 will be able to order a chargeable 
upgrade to full HATS offering
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Other Products
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Before and After WebFacing  

WebFacing
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After WebFacing

Can do more with 
existing application 
by using WDSc 
tools... 

... Like this
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Key Differentiators

IBM WebFacing Tool

Conversion tool .. from DDS source to JSPs

Semi-automatic conversion

No interactive feature required with V5R2 and new 
hardware

Designed for iSeries

Uses WDSc for iSeries to provide unique iSeries 
functions to programmer
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WebSphere Host on Demand

Internet
W

ebS
phere H

ost 
O

n-D
em

and

Java 
Applet

IBM iSeries

Web Browser
iSeries 
Legacy
 Apps

5250 Emulation

Basic 5250  Emulation 
translation from 5250 data stream to HTML at execution time
my be done via Java applet

Uses Screen Customizer for GUI
Available via WebSphere Host Access Client Package and 

WebSphere Host Integration Solution
Interactive Job Workload

TELNET
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Could use a combination of these products...
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Access for 
Web 
provides:

Access to 
functions not
available in 
the other 
products
Could be 
used as 
'entry' point 
to iSeries

Sample Web Page - users not familiar with iSeries
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Could use iSeries 
Access for Web 5250 

interface

Boats Application - iSeries Access for Web 5250 interface

Or HATS LE
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Could reface 
application using IBM 

WebFacing Tool

Boats application - WebFacing 

Or modernize with 
HATS
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Could completely 
reface application using 

WebSphere Host 
Publisher

Boats applications - Host Publisher
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Main Features iSeries Access for 
Web

Host 
Publisher WebFacing HATS

Web-enables existing 
Applications

Yes Yes Yes Yes

Based on Java technology Yes Yes Yes Yes

Presentation HTML, JSPs and Servlets HTML, JSP and 
Java Script

HTML, JSP and Java 
Script HTML

Runtime Environment WAS 
ASF Tomcat

WAS WAS WAS

Supported Browsers

MS Internet Explorer 5.0
Netscape 4.7 (AIX, 
Linux) and 6.2 
(Windows

Opera 5.0 (Linux), and 
6.0 (Windows)

MS Internet 
Explorer 5.0

Netscape 4.x or 
later versions

MS Internet Explorer 5.0 
or later versions

MS Internet 
Explorer 5.0

Netscape 4.x or 
later versions

Interactive Feature Required No - unless using 5250 Yes No - with V5R2 and new 
hardware Yes

Supported Host Interfaces 5250
5250, 3270, 
VT52, VT100, 
VT220

5250 - from DDS Source.  
Source must be available 
for each screen format

5250, 3270

Web-enables System 
Functions

Yes Yes
No - limited support for 
selected commands in 
WDS V5

Yes

SQL Database Access Yes Yes No - except through 
application changes

No - except 
through 
application 
changes
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Main Features (continued)

iSeries Access 
for Web Host Publisher WebFacing HATS

Host Application 
modernization

No, other than runs 
in browser Yes Yes Yes

Code Changes Required No No
No - although may 
choose to optimize 
for the Web

No

Programming effort to 
convert host interface to Web 
interface

None

Using Studio:
1. Record host screen 
navigations and create 
IOs that encapsulate 
those navigations.
2. Build JSP pages that 
require IO input and 
render IO output

None - unless DDS 
keywords are not 
supported by 
WebFacing

Two methods:
1. default 
parameters - no 
pgming effort
2. customization -  
tracing application 
execution path, 
defining rules

Customization
Can customize what 
iSeries functions 
user can access

Yes - JSP pages can be 
customized, and IOs can 
be reused in a WAS 
application (Servlet, Web 
Services, EJB)

1. CODE designer
2. Cascading style 
sheets
3. Web Tools

1. Web Tools

Allows exposure of Java 
artifacts to other tools

No No Yes
No - may create 
Java extensions to 
the application

Merge/split of application 
screens

No Yes - handled by macro 
recorder

Yes -with 
programming 
changes

Yes - handled by 
macro recorder

F
0
3
S
P

2
2
H

o
st

P
u
b
li
sh

e
rV

4
.p

rz

1
0
9



IBM eServer iSeries

© 2003 IBM Corporation

8 IBM Corporation 1994-2002.  All rights reserved.
References in this document to IBM products or services do not imply that IBM intends to make them available in every country.
The following terms are trademarks or registered trademarks of International Business Machines Corporation in the United States, other countries, or both:

Lotus, Freelance Graphics, and Word Pro are registered trademarks of Lotus Development Corporation and/or IBM Corporation.
Domino is a trademark of Lotus Development Corporation and/or IBM Corporation.

C-bus is a trademark of Corollary, Inc. in the United States, other countries, or both. 
Java and all Java-based trademarks are trademarks of Sun Microsystems, Inc. in the United States, other countries, or both. 
Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft Corporation in the United States, other countries, or both. 
ActionMedia, LANDesk, MMX, Pentium and ProShare are trademarks of Intel Corporation in the United States, other countries, or both. 
UNIX is a registered trademark of The Open Group in the United States and other countries.
SET and the SET Logo are trademarks owned by SET Secure Electronic Transaction LLC. 
Other company, product and service names may be trademarks or service marks of others.

Information is provided "AS IS" without warranty of any kind.

All customer examples described are presented as illustrations of how those customers have used IBM products and the results they may have achieved.  Actual environmental costs and performance 
characteristics may vary by customer.

Information in this presentation concerning non-IBM products was obtained from a supplier of these products, published announcement material, or other publicly available sources and does not constitute an 
endorsement of such products by IBM.  Sources for non-IBM list prices and performance numbers are taken from publicly available information, including vendor announcements and vendor worldwide 
homepages.  IBM has not tested these products and cannot confirm the accuracy of performance, capability, or any other claims related to non-IBM products.  Questions on the capability of non-IBM products 
should be addressed to the supplier of those products.

All statements regarding IBM future direction and intent are subject to change or withdrawal without notice, and represent goals and objectives only.  Contact your local IBM office or IBM authorized reseller for 
the full text of the specific Statement of Direction.

Some information in this presentation addresses anticipated future capabilities.  Such information is not intended as a definitive statement of a commitment to specific levels of performance, function or delivery 
schedules with respect to any future products.  Such commitments are only made in IBM product announcements.  The information is presented here to communicate IBM's current investment and development 
activities as a good faith effort to help with our customers' future planning. 

Performance is based on measurements and projections using standard IBM benchmarks in a controlled environment.  The actual throughput or performance that any user will experience will vary depending 
upon considerations such as the amount of multiprogramming in the user's job stream, the I/O configuration, the storage configuration, and the workload processed.  Therefore, no assurance can be given that 
an individual user will achieve throughput or performance improvements equivalent to the ratios stated here.

Photographs shown are of engineering prototypes.  Changes may be incorporated in production models.

AS/400 IBM(logo)
AS/400e iSeries
e (logo) business OS/400
IBM

Trademarks and Disclaimers

F
0
3
S
P

2
2
H

o
st

P
u
b
li
sh

e
rV

4
.p

rz

1
1
0


